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Введение

Оглянитесь вокруг: со всех сторон на нас смотрят плакаты и постеры, рекламные листовки и визитки, фотографии и открытки… Когда-то художник брал карандаш, перо или краски и создавал шедевр. Фотограф запасался пленкой и громоздкой камерой. Сейчас профессиональная работа с графическими изображениями невозможна без компьютеров.
Появление и распространение персональных компьютеров изменило многие профессии. Что касается издательского дела, произошла просто революция. Еще десять лет назад подготовкой и печатью публикаций занимались очень немногие люди. Большая часть этой работы выполнялась вручную. Хороший полиграфист знал все детали процесса и капризы оборудования и обладал высоким профессионализмом. Когда компьютеры стали достаточно мощными и появились качественные устройства вывода, начали развиваться программы, автоматизирующие процесс верстки публикаций, – настольные издательские системы. Операция, на которую в прежние времена опытный специалист затрачивал не один час, теперь выполняется простым нажатием нескольких кнопок. Бесспорным лидером отрасли уже многие годы является компания Adobe Systems Inc. Именно она первой реализовала программный и аппаратный интерпретаторы языка описания страниц PostScript, который используют все высококачественные устройства вывода изображений и, прежде всего, фотонаборные автоматы, составляющие технологическую основу современного цикла подготовки полиграфических оригинал-макетов. Программы Photoshop, Illustrator, FrameMaker, InDesign, Acrobat и другие образуют замечательный и мощный комплект программного обеспечения современного издательства.
Компания Adobe постоянно совершенствует пакет издательских программ в соответствии с требованиями времени и растущей вычислительной мощностью настольных компьютеров. Другим направлением развития этого набора программ является улучшение их совместимости и переносимости документов между ними. Поэтому выбор в пользу Adobe Photoshop – это одновременно и выбор всей линии издательских программ данной фирмы.
Новая версия программы обработки изображений Adobe Photoshop является безусловным лидером среди профессиональных графических редакторов за счет своих широчайших возможностей, высокой эффективности и скорости работы. Программа предоставляет все необходимые средства для коррекции, монтажа, подготовки изображений к печати и высококачественного вывода. Вторая, не менее обширная, сфера применения программы – Web-дизайн и электронные публикации. Новая версия Photoshop обогатилась множеством специальных функций, ориентированных именно на Web-дизайн. Можно совершенно без преувеличения сказать, что этот программный продукт находится в арсенале каждого профессионального компьютерного дизайнера и верстальщика.
Данный пакет интересен и незаменим как для профессионалов – дизайнеров, фотографов, специалистов по трехмерной графике, так и для любителей, например, таких как я, ведь даже в повседневной жизни мы часто сталкиваемся с необходимостью компьютерной обработки изображений. По всем этим вышеперечисленным причинам я решила раскрыть некоторые секреты именно этого редактора.



1. Знакомство с программой

Программа Adobe Photoshop появилась вместе с компьютерной графикой, сформировалась как отдельное направление и сейчас по праву занимает лидирующее место среди графических программ-редакторов. Photoshop предназначался для работы именно с растровой графикой, однако от версии к версии в нем появляется все больше инструментов для создания и редактирования элементов векторной, в том числе трехмерной, графики в составе растрового изображения. Сейчас Adobe Photoshop позволяет редактировать и растровую, и векторную графику. Хотя основное предназначение.
Adobe Photoshop – преобразование существующего изображения, в версии CS4 мы находим массу разнообразных инструментов и для создания оригинальных продуктов.

2. Палитры и инструменты

Рассмотрим подробно внешний вид и назначение каждого элемента панели инструментов.
Выпадающее меню. Во многих случаях оно еще называется Главное меню. Именно здесь собрана большая часть команд. Многие из них продублированы в других местах, либо при помощи горячих клавиш. Все опции в меню подобраны тематически. Так, например, в меню Image собраны опции редактирования изображения в целом, а в меню Layer – опции, необходимые для работы со слоями, и т.д. Выпадающее меню в совокупности своей содержит наиболее полный список опций для создания и редактирования изображений.
Панель навигации – новшество версии CS4. При помощи средств данной панели мы можем осуществлять навигацию по изображению, визуально масштабировать его, определять порядок выведения на экран изображений в случае работы сразу с несколькими файлами, а также вызывать дополнительное средство – Bridge. В более ранних версиях программы навигация по изображению осуществлялась при помощи средств дополнительной панели Navigator.
Панель инструментов – здесь собраны основные инструменты, имеющиеся в программе. Стоит отметить, что на ней поместилось далеко не все. Практически у каждого значка в правом нижнем углу вы можете увидеть небольшой треугольник.
Этот значок сигнализирует: здесь находится группа инструментов. Для ее просмотра надо нажать и немного подержать кнопку. Появится что-то вроде выпадающего меню, а в нем – остальные инструменты данной группы. Например, под инструментом Brush Tool, откроется группа, в которой будут Brush Tool, Pencil Tool и Color Replacement Tool.
Панели инструментов можно придать классический двухуровневый вид, тогда пиктограммы расположатся не в один, а в два столбца. Для этого надо щелкнуть по небольшой кнопке на верхней части панели – с двойной стрелочкой вправо.
Панель опций содержит характеристики текущего инструмента – в зависимости от того, что именно вы выбрали. Практически каждый инструмент требует настройки, указания его свойств или параметров.
Дополнительные панели. Под ними находятся вспомогательные инструменты и опции. Их состав может различаться. Для перехода к классическому виду этих панелей, раскройте выпадающее меню Window, убедитесь, что у вас выделены пункты: Color, Layers, Navigator.
Если панели опций и инструментов отсутствуют, в этом же меню поставьте галочки у пунктов Options и Tools .Как видите, интерфейс программы достаточно прост. Он не содержит большого количества элементов, и в то же время все необходимое находится под рукой. Внешний вид более ранних версий программы Photoshop значительно отличается от рассматриваемой. Вплоть до версии Adobe Photoshop CS2 интерфейс сохранял классический вид. При выпуске CS3 он был Рис. 5. значительно переработан, а новейшая CS4 имеет еще больше новшеств, значительно отличающих ее от предшественников.
Стандартные палитры
Многие элементы управления программы расположены в тематических палитрах – небольших окнах, которые, в отличие от обычных диалоговых окон, могут постоянно находиться на экране. Каждая палитра посвящена одной теме, например выбору цвета, работе с каналами изображения, выбору инструмента. Пользователь во время работы переходит от палитры к изображению и обратно, не тратя времени на выбор команды. Если палитра не нужна, ее можно убрать с экрана, а в случае необходимости вызвать вновь. Кроме того, палитры можно собрать в группы, чтобы они занимали меньше места на экране, или пристыковать к «доку» в верхней части главного окна.
В Photoshop есть 18 специализированных палитр.
Элементами палитры могут быть кнопки, ползунки, образцы, поля ввода. Кнопка со стрелкой вверху справа открывает меню палитры, где содержатся относящиеся к ней команды. Часто употребляемые команды вынесены в виде кнопок в нижнюю часть палитры. Ярлык с названием, похожий на ярлык каталожной карточки, служит для активизации палитры и для ее перемещения.
На верхней полосе палитры размещаются кнопки управления : кнопка с крестом закрывает палитру, с чертой – уменьшает ее так, что остается виден только ярлык с названием. Когда палитра уменьшена, черта на кнопке превращается в квадрат. Теперь щелчок по ней увеличит палитру до нормальных размеров. Некоторые палитры масштабируемы, их размеры можно изменить, перетащив серый штрихованный треугольник в правом нижнем углу палитры.
Команды-переключатели меню Window управляют видимостью палитр. Если палитра есть на экране, то пункт меню с ее названием помечен галочкой. При выборе этого пункта палитра немедленно исчезнет. Если палитра не видна, то ее название в меню никак не помечено и выбор. Стоит потренироваться в обращении с палитрами, чтобы чувствовать себя несколько увереннее в рабочем пространстве программы.
1. По умолчанию палитр управления текстом Character и Paragraph нет на экране. Откройте палитру Character, выбрав одноименную команду меню Window.
2. Палитра открыта. Рядом с ее ярлыком находится ярлык Paragraph т.е. эти две палитры объединены в группу. Чтобы активизировать палитру Paragraph, щелкните на ее ярлыке. Она вышла на передний план, а палитра Character теперь скрыта.
3. Переместите группу палитр, перетаскивая верхнюю полосу. Обе палитры смещаются одновременно.
4. В группе, как вы убедились, видна лишь одна «верхняя» палитра. Чтобы видеть обе палитры одновременно, «вытащите» палитру из группы: нажмите на ярлык и перетащите ее за пределы группы. Теперь видны обе палитры.
5. Сгруппировать палитры можно произвольным образом. Откройте палитру Swatches, если она закрыта. Нажмите на ярлык и перетащите его так, чтобы перемещаемый контур разместился точно поверх палитры Character. При этом вокруг палитры Character возникнет тонкая темная рамка. Отпустите кнопку мыши: палитры сгруппированы.
6. Испытайте другие элементы управления на примере палитры Swatches: уменьшите ее кнопкой с чертой, откройте меню, измените размер, перетаскивая серый треугольник в нижнем правом углу. Закройте палитру двумя способами: щелчком на кнопке и командой меню Window.
Панель инструментов Photoshop
Панель инструментов содержит кнопки графических инструментов Photoshop. Эти инструменты предназначены для быстрого выполнения большинства операций и процедур, связанных с выделением, раскрашиванием, редактированием и просмотром изображений. Кроме того, панель инструментов содержит управляющие элементы для выбора цветов переднего и заднего плана, переключения в режим Быстрая маска и изменения способа отображения изображений на экране. На кнопках некоторых инструментов есть маленькие треугольники в нижнем правом углу. Это свидетельствует о том, что у них имеются собственные раскрывающиеся панели дополнительных инструментов. Чтобы открыть такую панель, нажмите мышью на ее треугольнике.
Группы инструментов
Инструменты выделения
Rectangular Marquee Tool. Выделяет прямоугольные области. Для получения квадратной области при ее выделении удерживайте клавишу Shift.
Elliptical Mat quee Tool. Выделяет овальные области. Для выделения области в форме круга при ее выделении удерживайте клавишу Shift.
Single Rov Marquee Tool, Single Column Marquee Tool. Определяет выделенную область как строку толщиной в один пиксел, проходящую по всему изображению.
Crop tool. Вырезает из изображения выделенную область, отсекая ненужные фрагменты.
Lasso Tool. Выделение областей произвольной формы.
Polygonal Lasso Tool. Предназначено для выделения в изображении областей, ограниченных многоугольниками, составленными из отрезков прямых линий произвольной формы.
Magnetic Lasso Tool. Используется для создания выделений вокруг объектов. Границы области «цепляются» за края объекта, на которых происходит смена цветового тона и насыщенности.
Magic wand. Выделяет фрагменты изображения на основе сходства цветов смежных пикселов.
Инструменты рисования и закрашивания.
Healing Brush Tool. Позволяет наносить мягкие мазки основным цветом.
Eraser Tool. Используется для удаления оригинальных пикселов изображения путем закрашивания их в цвет фона.
Pencil tool. Позволяет рисовать линии с резкими краями.
Line Tool. Используется для рисования прямых линий.
Eyedropper Tool. Позволяет задать основной и фоновый цвета путем взятия проб цвета на изображении или из палитр «Синтез» и «Каталог».
Gradient Tool. Заполняет область постепенным переходом от одного цвета к другому
Paint Bucket Tool. Позволяет закрашивать однородные пикселы выделенной области изображения выбранным цветом.
Pen Tool. Используется для рисования контуров с помощью линейных сегментов путем создания набора закрепленных точек.
Add Anchor Point Tool. Используется для добавления новых узловых точек в контур.
Delete Anchor Point Tool. Используется для удаления узловых точек из контура.
Convert Point Tool. Используется для изменения свойств закрепленных точек.
Freeform Pen Tool.
Инструменты для редактирования.
Horizontal Type Tool, Vertical Type Tool. Позволяет создавать битовый горизонтальный и вертикальный текст.
Horizontal Type Mask Tool, Vertical Type Mask Tool. Используется для создания выделенной области в форме символов текста
Hand. Позволяет просматривать части изображения, не поместившиеся на экране.
Zoom tool. Увеличивает и уменьшает изображение.
Move tool. Используется для перемещения выделенных областей, слоев и направляющих.
Инструменты для ретуширования.
Smudge Tool. Имитирует эффект размазывания невысохшей краски пальцем.
Clone Stamp Tool. Позволяет воспроизводить точные или модифицированные копии элементов изображения и цветовых образцов в том же изображении, либо в другом документе.
Blur Tool. Позволяет смягчать слишком резкие границы или области в изображении, уменьшая контраст между пикселами.
Sharpen Tool. Позволяет повышать четкость изображения, делая слишком мягкие границы более резкими.
Dodge Tool. Позволяет осветлять отдельные области изображения.
Burn Tool. Затемняет отдельные области изображения.
Sponge Tool. Изменяет насыщенность отдельных частей изображения.
Инструменты настройки рабочей среды.
Редактирование в стандартном режиме. Выполняет функции основного режима при работе в Photoshop. В нем выделенные области отображаются с помощью движущейся пунктирной границы.
Редактирование в режиме Быстрой маски. Используется для создания и редактирования временных масок, что обеспечивает возможность одновременного просмотра маски и изображения. Вы можете выделить в изображении первоначальную область, а затем войти в режим Быстрая маска и с помощью рисующих инструментов модифицировать ее. После выхода из этого режима незащищенные участки будут преобразованы в выделенную область.

3. Работа со слоями

Открываем палитру слоёв.
Начнём с того что откроем палитру слоёв в фотошопе. Если она у вас ещё не открыта, то идите в Window и выберите из списка Layer или же просто вызовите палитру нажатием клавиши F7. Открыв любой документ в фотошопе вы увидите как в палитре слоёв появилась иконка с этим изображением. Слой в документе один и Рис. 8 в палитре слоёв тоже будет отображаться один слой.
Слои можно сравнить со стопочкой книг, листов из тетрадки или альбомом. Вы складываете, а вернее накладываете слои друг на друга как складываете книги в стопочку. Вы можете поменять книги местами, можете убрать из стопки книгу, или добавить ещё одну. Надеюсь для тех кто совсем незнаком со слоями, сравнение со стопкой книг немного помогло в этом разобраться.
Выделение слоя.
Если слой окрашен в синий цвет, это говорит о том, что этот слой выделен и вы можете с ним работать: перетаскивать, удалять, добавлять эффекты слоя и так далее, то есть: все изменения которые мы будем производить коснуться только выделенного Чтобы выделить другой слой, в данном случае это само изображение нужно кликнуть по нижнему слою мышкой, и выделится нижний слой.
Видимость слоя.
Мы можем выключить слой с бабочкой, нажав на иконку с глазом, рядом с иконкой слоя с бабочкой). Слой с бабочкой стал невидимым, что бы вернуть ему видимость нужно снова нажать на глаз. Слой с бабочкой стал видимым:
Таким образом, мы можем отключать видимость любого слоя находящегося в палитре слоёв если они нам временно не нужны или в данный момент мешают видеть свои действия на мониторе.
Перетаскивание слоя.
А теперь посмотрим, что мы можем делать ещё со слоем с бабочкой. Мы можем перетаскивать нашу бабочку по всему файлу, куда нам заблагорассудится, но для этого в палитре слоёв должен быть выделен слой с бабочкой, и не забудьте воспользоваться инструментом Move Tool из палитры инструментов. Перетащив бабочку в нижний угол вы увидите, что и в палитре слоёв произошли некоторые изменения, на иконке слоя с бабочкой, она тоже теперь находится в нижнем левом углу. То есть всё что мы делаем в документе с нашими изображениями, обязательно отражается на слое в палитре слоёв.
Дублирование слоя.
Что мы можем ещё сделать с нашей бабочкой в палитре слоёв? Конечно же продублировать. То есть создать точно такой же слой с бабочкой. Для этого мы должны или: Нажать правой кнопкой мыши на слой с бабочкой в палитре слоёв и из списка выбрать: Duplicate layer… Или в верхней панели опций выбрать: Layer>Duplicate Layer : Или же перетащить иконку слоя в нижний правый угол на иконку похожую на квадратик с загнутым уголком Create a new layer : И самый простой и чаще всего применяемый способ это сочетание клавиш Ctrl+J. Новый слой с бабочкой автоматически был создан над выделенным слоем. В палитре слоёв три слоя, а в самом файле мы видим всего-то наш фон и бабочку, но это только потому что фотошоп создаёт дубликат слоя строго над тем же слоем что у нас был. Потяните инструментом Move.
Переименование слоя.
Слоёв в палитре становится уже много, и если при работе с файлом вы создаёте много слоёв, то чтобы не запутаться, можно слои переименовать: двойной клик по названию слоя в палитре слоёв, и вписывайте любое описательное название.
Разблокирование слоя.
Заметьте что при двойном клике на нижний слой Background у нас всплывает диалоговое окно. Происходит это потому что слой заблокирован. Заблокированный слой мы не можем двигать, применять к нему некоторые действия.
Для разблокирования слоя дважды кликнете по слою в палитре слоёв, всплывёт диалоговое окно в котором вы можете также поменять название слоя, нажимайте ОК. Слой разблокируется и изменится название слоя. Кроме названия мы можем изменить цвет, Режим смешивания.
Создание нового пустого слоя.
Чтобы создать новый пустой слой, нужно нажать на иконку в виде квадратика с загнутым листочком в основании палитры слоёв. Фотошоп автоматически создаст слой над выделенным слоем. Или же в верхней панели опций нажать на Layer>New>Lawer : Или же создать новый слой сочетанием клавиш Shift+Ctrl+N. Вот сколько возможных вариантов создания слоя.
Удаление слоя.
Чтобы удалить ненужный слой, правой кнопкой мыши нажимаем в палитре слоёв на слой который хотим удалить, и из списка выбираем: Delete Layer или: в верхней панели опций выбираем: Layer>Delete>Layer.
Или же: в палитре слоёв мышкой нажимаем на слой и перетаскиваем в корзинку, которая находится в основании палитры слоёв. Слой удалится:
Ну и ещё один способ удаления слоя. При активном инструменте Move Tool, выделяем слой от которого хотим избавиться и нажимаем клавишу Delete. Меняем слои местами.
Слои в палитре слоёв можно менять местами. Перетаскивать наверх или вниз. Все эти манипуляции производятся мышью. Просто захватываете мышью нужный слой и перетаскиваете его вниз или вверх:
Блокировка слоёв.
Следующий ряд Lock Замок. У нас их четыре. При нажатии на первую блокировку мы не сможем редактировать прозрачные пиксели, при нажатии на вторую блокировку нельзя будет редактировать прозрачные и непрозрачные пиксели. Третий значок заблокирует объекты слоя от перемещения, и четвёртый значок заблокирует всё. Нельзя будет редактировать, двигать, удалять слой, но можно будет перемещать между слоями.

4. Работа с текстом

Очень часто рисунки дополняются текстовым сопровождением, которое придаёт осмысленность картинке. Текст тоже может быть предметом дизайна или частью дизайнерской композиции поэтому от версии к версии Photoshop дополняет свой арсенал работы с текстом.
При работе с текстом следует помнить одно главное правило – в основе свой шрифты являются одним из видов векторной графики. Этот факт имеет принципиальное значение при работе с текстом в среде Photoshop, поскольку там текст создаётся на отдельных векторных слоях, на котрых не применима растровая графика ни в каком её проявлении. Для создания текста существуют специальные инструменты. Первый инструмент Horizontal Type Tool создаёт текстовый слой, на котором текст размещается совершенно традиционным горизонтальным образом. Второй инструмент Vertical Type Toolсоздаёт текстовый слой, на котром текст размещается сверху вниз. Следующие два инструмента не создают текстового слоя принципиально. Они создают выделение в виде текста, причём инструмент Vertical Type Mask Tool создаёт текстовое выделение которое распологает буквы текста сверху вниз, а Horizontal Type Mask Tool создаёт текстовое выделение слево направо. Выделение в виде текста необходимо тогда, когда вы хотите иметь сразу готовый растровый слой содержащий текст без мучения с преобразованием векторного текстового слоя в растровый.
Текстовый слой легко отличить от других слоёв по его иконке в строке слоя политры Layers. Если обычный слой имеет иконку ввиде его миниатюрного отображения, то текстровый слой имеет иконку содержащую букву T. Когда вы вибираете инструмент работы с текстом, то на панели свойств появляются настройки текста.
Управление текстом совершенно традиционно. Вы можете выбрать шрифт, его размер, его начертание – обычное, полужирное, наклонное – также вы можете определить отображение шрифта – сглаженное, резкое, чёткое. Если у вас несколько строк текста, то для них можно определить выравнивание – по левому краю, по центру, по правому краю. Достаточно важной настройкой является возможность пустить текст по траектории. Для этого вам предоставляются шаблоны кривых, по траектории которых и будет располагаться текст.
В разделе Style вы можете выбрать вид траектории, а затем при помощи дополнительных настроек довести текст до ума.
При положении ползунка изгиба не будет, а при отрицательных значениях деформация пойдёт в противоположную сторону. Horizontal Distortion управляет искажением текста по горизонтали. Положительные значения увеличивают правую часть текста, отрицательные – левую.
Vertical Distortion занимается искажениями по вертикали. Положительные и отрицательные значения действуют следующим образом:
Что касается дополнительных настроек текста, это уже скорее из области вёрстки. При нажатии у вас возникает на экране две новых палитры, собранных в одну группу. Палитра под названием Character управляет символами. В этой палитре можно настроить опять таки шрифт, его начертание, размер шрифта, расстояние между строками, расстояние между символами и кернинг пар. Сразу возникает вопрос – что это? Вы наверное знаете что такое обман зрения. В данном случае кернинг пар это борьба против этого обмана.
Как вы видите, существуют такие пары букв, расстояние между которыми визуально кажется большим, чем расстояние между остальными буквами. Для устранения этого оптического обмана применяется операция кернинга, т.е. уменьшения расстояния между буквами такой пары. Обычно такая операция проделывается автоматически, но в любом, более менее серьёзном текстовом редакторе есть возможность установить такое расстояние вручную. Соответственно есть такая возможность и у Photoshop.
Также есть возможность изменить высоту символов и ширину символов. Для этого служат поля с буковкамиT и соответствующими стрелками. Поле предназначено для смещения выделенных символов вверх или вниз относительно остальной строки. Если в поле ввести положительные числа, то выделенные символы сместятся вверх, а если отрицательные, то вниз относительно базовой линии текста.
Ниже сосредоточены кнопки управления текстом. Кнопка делает начертание выделенного текста жирным, кнопка наклонным. Кнопка предназначена для того, что бы перенести символы из нижнего регистра в верхний, и наоборот. А эта кнопка трансформирует выделенные символы в заглавные буквы, сохраняя при этом размер строчных символов. При помощи кнопки вы переводите выделенный символ в верхний регистр, при помощи кнопки в нижний. Предпоследняя кнопочка этого ряда позволяет подчеркнуть выделенные символы, а последняя перечеркнуть. Ниже вам даётся возможность выбрать словарь для орфографической проверки и тип сглаживания шрифтов.
Вторая палитра управления текстом носит название Paragraph. Paragraph это особый вид текста – блочный текст. Разница состоит в том, что блочный текст это понятие вёрстки, т.е. вы инструментом Type Tool рисуете прямоугольную область, в которую вписывается текст. Т.е. это блок текста, который подобен странице в Word.
Соответственно у такого вида текста уже больше возможностей в настройке. Вверху палитры находятся разнообразные виды выравнивания. Часть этих видов вы уже знаете. Кнопка выравнивает текст по ширине, последнюю, незаконченную строку располагает по центру абзаца, кнопка также выравнивает текст по ширине, но последнюю, незаконченную строку прижимает к правому краю относительно абзаца, а кнопка растягивает последнюю строку на всю ширину абзаца за счёт интервалов между словами. В поле вы можете задать для абзаца отступ от левой границы блока, а в поле от правой границы. Поле позволяет задать отступ первой строки абзаца. Поле указывает на нижний отступ абзаца, а поле на верхний. В самом низу палитры находится флажок – включение автоматического переноса слов. На последок стоит добавить, что любой текстовый слой можно превратить в растровый, и далее работать с ним как с растровым. Это делается командой Rasterize Layer из контекстного меню текстового слоя или из меню Layers|Rasterize.

5. Фильтры

Обзор фильтров
Многие из спецэффектов, которые можно создать с помощью Photoshop, достигаются исключительно на основе встроенных фильтров и определенной фантазии дизайнера. Фильтры – это подпрограммы в составе Photoshop, выполняющие работу по обработке изображения и основанные на математических операциях.
Существует понятие стандартных фильтров. Это фильтры, загружаемые вместе с программой. Помимо них существует целая индустрия по производству фильтров, которые можно добавить в Photoshop самостоятельно, устанавливая файлы с новыми фильтрами в папку Plug-ins.
Что следует знать о фильтрах:
• Фильтры подразделяются на художественные, служебные и фильтры с собственным интерфейсом. Художественные предназначены для улучшения изображения с точки зрения, а служебные – для решения задач улучшения качества изображения или приведения его в соответствие условиям, заданным автором. Фильтры с собственным интерфейсом используются для специфических задач, решение которых требует инструментов, которыми сам Photoshop не располагает.
• Не все фильтры работают во всех цветовых пространствах. Многие фильтры не работают в модели CMYK, о чем должны помнить дизайнеры, переводящие документ в эту цветовую модель заранее.
• Фильтры можно применять как к целому слою, так и к выделенному участку слоя.
• Фильтры бывают настраиваемые и ненастраиваемые. Настраиваемые фильтры имеют диалоговые окна с параметрами, ненастраиваемые – нет.
• Ослабление действия фильтра осуществляется командой Edit | Fade, причем это не так просто, как кажется.
• Скорость действия фильтра зависит от размера вашего файла.
Группы фильтров :Extract, Filter Gallery, Liquify, Pattern Maker, Vanishing Point, Artistic, Blur, Strokes, Distort, Noise, Render, Sharpen, Sketch, Stylize, Texture, Other.
Выделение сложных объектов
Диалоговое окно с возможностью предварительного просмотра и параметрами действия фильтров. Содержит не все фильтры, будьте аккуратны! Создание искажений с использованием сетки, разнообразие инструментов. Создает текстуры, но лучше делать их вручную. Создание перспективного искажения с использованием сетки и точек. Не заменим в ретуши перспективы. Предназначены для моделирования всевозможных художественных приемов и техник, которые используются в традиционных областях искусства. Сюда относится имитация рисунка карандашом и пастелью, живописи акварельными красками, гравюры. Предназначены для задач, связанных с уменьшением резкости и обеспечением разной степени смягчающего эффекта. Придание изображению вида графических произведений, выполненных различными инструментами и имитирующих различные художественные манеры. Служат для геометрических искажений изображения. Добавляют в изображение пикселы со случайными цветовыми значениями и тем самым как бы смягчают изображение в выделенной области.
Предназначены для создания мягкой облачности, имитации эффекта паразитной засветки в объективе фотокамеры, различных эффектов освещения и применения текстур из полутоновых документов. Предназначены для усиления резкости. Предназначены для имитации художественных инструментов и материалов, традиционно используемых для набросков или подготовительных работ. Включает фильтры, позволяющие имитировать те или иные приемы работы с изображением за счет смещения пикселов или повышения контраста. Предназначены для заполнения изображения или его фрагментов повторяющимися декоративными рисунками. Предназначены для решения разнородных задач, которые не попадают в тематические группы.
Служебные группы фильтров Photoshop
К служебным фильтрам относятся фильтры: Blur, Noise и Sharpen.
Blur. Эффект применения фильтров этой группы заключается в размытии переходов между областями различного цвета. Самым универсальным является фильтр Gaussian Blur.
Noise – с их помощью строятся естественные структуры и размываются слишком гладкие поверхности. Фильтры этой группы предназначены как для добавления, так и для удаления шумов.
Sharpen. Фильтры, позволяющие увеличить контраст и подчеркивающие детали изображения. Наиболее часто используемый – Unsharp mask.

6. Каналы и маски

Маски используются для скрытия и отображения определенных фрагментов изображения, а также для ограничения области воздействия настроечных слоев.
Маски бывают двух типов – векторные и растровые. Первый тип нас пока не интересует, рассмотрим второй тип. Растровая маска представляет из себя черно-белое изображение. Черный цвет означает, что соответствующий пиксель изображения будет абсолютно прозрачным, белый – абсолютно непрозрачным. Все промежуточные цвета соответствуют разным степеням прозрачности. Таким образом, всего у изображения может быть 256 градаций прозрачности, а не 100, как привыкли думать веб-разработчики.
Утверждение про 256 градаций справедливо для изображений с 8 битами на канал, для изображения с 16 битами на канал будет 65536 градаций. Маска удобна тем, что она не вносит изменений в исходное изображение. На маске можно использовать любые инструменты рисования, не опасаясь допустить необратимых ошибок.
Каналы – это те же черно-белые изображения, но отвечают они за интенсивность цветового компонента в текущей цветовой модели. Например, в цветовой модели RGB есть три канала: красный, зеленый и синий. Соответственно, пиксели в этих каналах отвечают за интенсивность того или иного цвета. Посмотреть на них можно в палитре Channels.
каналами и масками, помимо того, что они черно-белые? Ну, во-первых, они все отображаются в палитре Channels. Второе, и самое важное, Ctrl+клик или клик по слою с каналом канал. Это именно та глубина цвета, с которой вам в основном придется работать. Но такой глубиной цвета возможности современной техники не ограничиваются. В частности, Photoshop позволяет работать с глубиной цвета 16 битканал. Но нужна ли такая большая глубина цвета? Глубиной цвета 16 битканал используются как источник света в трехмерных сценах – это уже отдельная область дизайна. В дальнейшем мы будем иметь дело только с изображениями, имеющими глубину цвета 8 бит Load Selection и LayerInverse, и применим фильтр FilterCrystallize с коэффициентом кристаллизации 8.
3. Опять выполняем команду SelectNoiseBlurNone и используем фильтр FilterBlur.
5. Выполняем команду ImageInvert.
6. Выполняем команду Image90 CW. Затем применяем фильтр FilterWind. и возвращаем картинку в горизонтальное положение Image90 CCW.
7. Придадим изображению цвет льда с помощью команды Image HueSaturation
8. Добавим искрящиеся блики с помощью дополнительных кистей. В меню Brushes выберите команду Load Brushes и откройте файл assorted.abr из подкаталога Brushes. Установите текущим белый цвет и нанесите искорки на некоторые выступающие льдинки.
Разбитый текст
1. Создадим новое изображение и напишем текст
2. SelectLayer 1 Transparency, затем SelectInverse и применяем фильтр FilterAdd Noise Amount ставим в положение 300–400.
3. Запускаем фильтр FilterCrystallize с Cell Size 20–30. Затем используем фильтр FilterGlowing Edges с параметрами: Edge Width – 2, Edge Brightness – 20 и Smoothness – 1. Отменяем выделение – SelectBlurLoad SelectionIverse, SelectExpand by 1 pixel и SelectFillFlatten Image и фильтр FilterDrop Shadow
Придание фото 3D реализма
1. для начала вам потребуется картинка. Я использовала ту, что находится ниже, на рисунке 31.
2. теперь мы обрежем данное изображение, что бы затем сделать границу. Растяните Crop Tool, и удерживая одновременно Alt и Shift потяните за угловой квадратик, выходя за пределы изображения. Когда получите нужную вам границу, нажмите Enter.
3. Создадим новый слой-подложку и зальём его белым. Теперь объединим оба слоя. Теперь у нас должно получиться что-то вроде этого.
4. Теперь сделаем слой с тенью. Сделайте выделение. Создайте новый слой, заполните его чёрным и назовите «Shadow»
5. Теперь мы увеличим размер холста, опять воспользовавшись инструментом Crop Tool. Удерживая одновременно Shift и Alt, вытяните Рис. 32 один из уголков за пределы изображения, пока не увеличите холст минимум на половину. Смотрите мой пример ниже.
6. Повернём холст на 90 градусов по часовой стрелке Image > Rotate Canvas > 90° CW.
7. Идём в Filter > Distort > Shear и применяем следующие параметры.
8. Поворачиваем картинку обратно Image > Rotate Canvas > 90° CCW
9. Теперь применяем размытие по Гауссу к слою «Shadow».
10. Уменьшите прозрачность этого слоя до 60%
11. Теперь сделаем блик для нашей фотографии. Для этого сделаем новый слой, поместим его поверх остальных. Далее воспользуемся полигональным лассо. Установим размер растушевки около 25 px и зальём всё это белым цветом.
12. Уменьшаем прозрачность этого слоя до 50%. Снимите выделение
13. Теперь объединяем все слои, за исключением белого фона.
14. Напоследок воспользуемся Free Transform Tool, и поверните изображение вправо.
Капля воды
1. Откройте в Photoshop изображение, на которое требуется нанести одну или более капель. В данном примере было использовано изображение листа.
2. Добавим новый слой, нажав на иконку нового слоя на палитре слоев, или нажав комбинацию Shift+Ctrl+N. Создайте на нем выделение, использовав Эллиптическое выделение. У вас получится круг, но это не принципиально, в природе не бывает идеально круглых капель. Но в данном уроке для простоты усвоения, мы сделаем так. Так же лучше, если вы создадите выделение, по размеру близкое к нашему, что бы результат был лучшим. По окончании урока вы получите опыт и сможете уже создавать капли любого размера и формы.
3. Нажмем клавишу D на клавиатуре, что бы сбросить цвета в стандартные.
4. Не снимая выделение, выберем Градиент. В настройках должен быть указан линейный градиент
5. Убедитесь, что градиент идет из черного в белый. если это не так, проверьте, что не отмечен параметр С.
Теперь мы создадим заливку слева направо. Начать нужно будет с красной точки и закончить на синей.
6. После этого снимем выделение, нажав комбинацию Ctrl + D на клавиатуре.



Список литературы

1. А.П. Кириленко. Photoshop CS2 – стань профессионалом! Самоучитель.
2. GreatWeb.Ru: портал для пользователей ПК; 2002–2005. – Режим доступа: greatweb.ru.
3. iXBT.com: журнал для пользователей ПК.
4. 3DNEWS: DailyDigitalDigest: портал новостей; Режим доступа: http:www.3dnews.ru.
5. Вебпланета: ежегодный электронный журнал; 2001–2005. – Режим доступа: http:www.webplanet.ru
6. OHCT.COM: обзор техники; 2001–2001. – Режим доступа: http:www.ohct.com.
7. Софт@mail.ru: каталог программ; 2003. – Режим доступа: http:soft.mail.ru.
8. [bookmark: _GoBack]SoftRing: интернет-энциклопедия полезных программ.
